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Project Explorer 

Overview 

The Project Explorer provides easy access to all the features of XLReporter.  It is opened from the 

Start menu of Windows or from the shortcut added to the desktop during installation. 

 

The interface consists of a menu ribbon and multiple panes for viewing project templates and status. 

 

 

Open a Project 

From the menu select File, New Project to create a new project or File, Open Project to open an 

existing project. If the desired project does not appear in the dropdown list, it can be browsed to using 

the button to the right of the dropdown. 

 

 
 

Select New Project to start the Project Wizard to guide you in creating a project or Open Existing 

Project and choose a project (identified by a file with extension prj). 

 

For the Distributed edition, after opening a project you are prompted to update the web portal.  This 

requires administrator rights.  If you cannot provide those rights, you may not be able to view reports 

in the web portal. 
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Backup a Project 

To backup a project, select File, Backup Project.  This creates a compressed copy of the project.   

 

The backup is based on the File Management configuration xlrProjectBackup which can be modified 

in Tools Tab, Application, File Manager.  By default, this is set up to back up the project’s Input 

and Data directories as well as any logs or reports generated within the last week. 

Restore a Project 

To restore a project that has been backed up using the Backup Project option, select File, Restore 

Project.  Browse to the .zip file of the backed-up project and click Open.  This can be very useful 

when transporting a project from one machine to another. 

 

A project is restored to the original location it was backed up from.  If a project exists in this location, 

the project is not restored, and an error message is shown.  In order to restore an existing project on the 

system you must remove or rename the existing project folder. 

 

If the original location is not available on the system, the project is restored in the same folder structure 

on the drive where XLReporter is installed.  Additionally, the drive specified for the Reports, PDF 

and Web folders are updated if they are also set for the drive that is not available. 

 

This means that if the project was originally located in D:\XLRprojects\My Project and then brought to 

a new machine that does not have a D drive and where XLReporter is installed on the C drive, when 

restored, the project is restored to C:\XLRprojects\My Project. 

 

Project Wizard 

The Project Wizard guides you step-by-step in creating a new project. 

• Step 1 

 
 

Enter the Project Name and Description. The Project Location determines where the 

project will be saved. 
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• Step 2 

 

 

Configure data connector(s) to the data sources used in the project. 

 

For the Distributed edition, after creating the project you are prompted to update the web portal.  This 

requires administrator rights.  If you cannot provide those rights, you may not be able to view reports 

in the web portal. 

Project Explorer Menu Ribbon  

The Project Explorer menu ribbon consists of four tabs Home, Data, Project, and Tools. 

Home Tab 

 
 

The current registration status of the license is displayed in the right panel. To register the product or 

start an evaluation, select Register Product.  This item opens the registration dialog. 

 

If user accounts are enabled from the Project tab, User Accounts then Log On/Off is used to log in 

and out users. 

 

Templates are created in two ways.  One way is to select a pre-defined template from the Template 

Library and customize it for your application. The second is to create a new template in the Template 

Studio. 

 

Template Categories can be added to the project to help organize the report templates in applications 

like On-Demand Reports and the Web Portal.  See Template Categories below for details. 

 

Reports are produced from the template automatically by the Scheduler or on-demand with custom 

settings using On-Demand Reports.  

 

Data Entry Forms are provided to allow operators to collect manual data and store the data to a 

backend database so the information can also be used for reporting e.g., operator rounds. 

 

Secure viewers are provided to view reports in Excel, PDF, and HTML format.  The viewers do not 

require pre-installed software (e.g., the Excel viewer does not require an installation of Excel) and 

allow managed edits to the report.  These viewers are designed to be accessed from HMI displays. 
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The Status Logs are used to view any notifications or errors that are generated when actions are 

processed.  

 

The Audit Logs keep track of changes made to the project when the Audit Trail connector has been 

created (see SETUP, Implement Project Security).  

Data Tab 

 
 

Connectors specify the data source definitions such as a PLC, Historian, or relational database.  

 

To add flexibility to templates, Variables can be used instead of a hardcoded setting. The values of the 

variables are assigned “outside” of the template e.g., from an on-demand report. 

 

Analytics compute aggregated data and optionally save the results to a database for reporting. 

 

Event Frames are used to record specific time frames based on process events for use in reports. 

Project Tab 

 
 

The Settings options are used to modify settings of the project such as the folder where the reports are 

stored. 

 

When security is enabled, the user’s capability is limited by their security privileges. 

 

Reports can be produced automatically and in the background by the Scheduler.  Schedules are 

defined in the Designer to run “actions” on time or events. 

Tools Tab 

 
 

The Database Manager is used to maintain databases by doing such things as adding or removing 

tables and columns or previewing data stored in a table. 

 

The DSN Settings is used to add and remove 32-bit ODBC database sources. 
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For reports that are emailed, either from the Scheduler or from On-Demand Reports, use Email and 

SMS to specify a mail server and user configurations. 

 

For reports or files that are moved to/from an FTP server, use FTP Transfer to specify FTP Server 

configurations. 

 

For reports or any other system files that need to be managed, such as moving and purging, use File 

Manager to configure file management actions. 

 

To export the content of a report to a custom XML file use the XML Designer.  This is applicable for 

the eDMR submission in W/WW Treatment. 

The File Archive is used to restore project files to earlier iterations when security is enabled. 

 

Use Themes to maintain a consistent appearance of the reports. Themes can be specified for report 

content, chart lines and conditional formatting. 

 

The System Check is used verify reading/writing to real-time data connectors. It is also used to 

perform a scan of the installation, and to repair any defects.   

 

The Task Monitor is used to view the current state of the system including the active reporting queue. 

 

To check the integrity of the installation and the communication to the data sources use System 

Check.  For quick access to adding and removing Data Groups, use Connector Groups. 
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Project Explorer Panels  

  

Left Panel 

The left panel of the Project Explorer shows a list of all the templates defined in the project.  By 

selecting the  icon under the project name, the display toggles between the default view and the 

Category view if categories have been configured in the project.   

 

When a specific template is selected, the lower half of the panel updates to show the data connections 

defined in the template.   

 

A template or a specific item in the template can be modified by double clicking the item or right 

clicking and selecting an option.    

Template Instance 

A Template Instance is a set of parameters and specified values that can be stored and then reloaded 

when generating a report on demand.  Instances are displayed as branches under the template name. 

 

Example: Suppose a report is required for three identical machines. One solution would be to create a 

template for one machine, duplicate and modify for the other two.  This approach can lead to 

inconsistencies because any change in the template will have to be mirrored to the other two. 

A better approach would be to create a master template for a machine and then to create three instances 

from the master template, sharing the same layout but containing their specific machine settings. 

Template Instances are created from the On-Demand Reports. In On-Demand Reports select the 

Instance button next to Refresh 
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Right Panel  

The right panel of the Project Explorer shows the registration status of the project and a list of 

licensed project components (showing which are enabled based on the license). 

 

The status panel turns red when registration times out.  At this point open registration to extend the 

evaluation period.  If the panel is orange then this indicates the project is off-line. 

Template Categories 

A project can consist of many different report templates designed for specific areas of the plant or for 

different audiences.  By default, when templates are listed in the Project Explorer, On-Demand Reports 

application and Web Portal, everyone is listed in alphabetical order. 

 

Template Categories is available to help organize the report templates in the project so that the right 

people can find the reports that are important to them.  To configure, from the Project Explorer, under 

the Home tab select Template, Category. 

 

 
 

Until a report template is assigned to a category, it appears under the Report Templates folder.   

 

To add a new category, click the Add button and specify a name.  Once a category is added, a template 

may be added to it by highlighting the template and dragging it to the category folder.  Templates are 

listed in the order shown under the category.  This order may be changed by dragging the template up 

or down under the category.  Note that the order of templates cannot be changed under the Report 

Templates folder.  For this folder templates are listed in alphabetical order. 

To modify the name of an existing category, select the category folder and click the Modify button.  

Note that the Report Templates folder cannot be modified. 

 

To delete a category, select the category folder and click the Delete button.  Any template set to the 

deleted category is moved to the Report Templates folder. 

 

Initial State 

Consideration should be given to the expanded/collapsed state of a Category branch since this will be 

the initial state when presented to the user in a windows/web client. 

 

Close the Category Designer to have the configured categories available in the project. 

Usage 

The template list in the left panel of the Project Explorer and the On-Demand reports application can 

be toggled between the standard list and the category list by clicking the toggle button in the upper left 

corner. 
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From a windows client: 

    
From a web client 
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Information in this document is subject to change without notice.  SmartSights, LLC assumes no 

responsibility for any errors or omissions that may be in this document.  No part of this document may be 

reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without 

the prior written permission of SmartSights, LLC. 

 

 

 

 

 

 

Copyright 2000 - 2024, SmartSights, LLC.  All rights reserved. 

 

 

XLReporter® is a registered trademark of SmartSights, LLC. 

 

Microsoft® and Microsoft Excel® are registered trademarks of Microsoft, Inc. 

All registered names are the property of their respective owners. 
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